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Conventions used in this document
The following conventions are used not only in this guide but throughout
the suite of SPECTRA user manuals.

Common terms
Field The portion of a window in which SPECTRA displays an individual item

of data is referred to as a Field.

(Left) click Press the left mouse button once.

Right click Press the right mouse button once.

Double click Press the left mouse button twice in quick succession.

Select Use the mouse to point to an item, then left click.

Use of fonts
References to a single menu or menu item, or “buttons” on windows, are
shown in italics, for example Communications.  Sequences of menu
selections are also shown in italics, separated by vertical bars, for
example File|Apply.

Command lines are shown in a monospaced font.  Optional parameters
are shown in square brackets and variable text in italics.  Choices are
separated by vertical bars.  For example:

dn -N network [-X filename.DN] [-E] [-B|-BC]
    [-BTIMEOUT] [-AUDIT] [-FLIP]
    [-CDE workspace] [-S filename.SHP]
    [-H|-?|-h] [label]

Note: Notes and useful definitions are in shaded boxes, with the note title in
the margin, as in this example.

Use of the term “node”
The word "node" can mean either a software module or a point on a
network.  Usually the meaning is obvious from the context.  However, to
differentiate between these two uses, either an upper case or a lower case
first letter is used:

•  a Node is a SPECTRA software module;

•  a node is a point on a network from/to which observations are made.

For example, the system’s Network Calculation Node (NCN) uses
observations to compute network node positions for a selected network.
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Assumed knowledge & expertise
This set of manuals is not a tutorial.  To get the best out of SPECTRA,
and to use these manuals effectively, you should have successfully
completed the following basic training course:

•  SPECTRA Integrated Navigation System Operation – Basic.

In addition, for those with some basic experience of using SPECTRA,
advanced training courses can be arranged on specific topics.

For details of these and other courses, contact the Training Officer at
Concept Systems Ltd.

It is also assumed you are familiar with the operation of whichever
windowing system is installed on your workstation.  Refer to your
Windows user manuals for details on windows and how to use them, and
for information on how to use the different types of menu that may be
displayed in the windows.
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Chapter 1 -  Introduction

This chapter gives you an idea of what SPECTRA is and how it fits together.

What is SPECTRA?
SPECTRA is a comprehensive integrated seismic navigation system with
a modular design allowing customers to quickly reap the benefits of any
innovations in navigational techniques.

With approval from all major oil companies and used fleet-wide by the
majority of leading seismic contractors, Concept Systems provide 24
hour system support and are committed to a policy of continuous
improvement to keep pace with ever increasing positioning and quality
control demands.

SPECTRA is based on an expandable network of UNIX workstations
with a dedicated real time navigation sensor acquisition system
(RTNU/RTNµ) providing access to a tried and tested database of over
100 different navigation sensors and closure timing to a 50 micro-second
resolution.

Any number of workstations can be networked, providing flexible
configurations to meet individual customer needs ranging from simple
2D operations, 3D high-resolution applications to complex 3D multi-
vessel, multi-streamer surveys.

Key benefits

•  Navigation acquisition and validation with real time source and
streamer positioning for marine seismic surveys ranging from simple
2D and high resolution  requirements to extensive 3D multi-streamer,
multi-vessel configurations.

•  Distributed Data Server provides simple connectivity to easily
configure complex multi-vessel surveys.  Real-time data acquisition
units with integrated GPS receiver provide triggering to 50 micro-
seconds, allowing remote synchronisation of seismic and acoustic
systems.

•  Real-time binning, CMP and offset distribution displays.  Fully
compatible with Concept Systems REFLEX off-line binning and
analysis package including bin expansion capabilities.

•  Data logging to UKOOA P1/90, P2/91 and P2/94 standards with full
redundancy, providing confidence in data integrity.

•  Quality Control features providing alarm and audit facility meeting
UKOOA guidelines.  Extensive on-line graphical analysis features and
end of line reporting facilities.

•  Positioning using Kalman filtering with advanced data-snooping
statistical testing techniques.
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•  DGPS and RGPS real-time recomputation.

•  Autopilot interface controlled from instrument room leaving the
navigator in charge of steering.  This facility is fully integrated with a
comprehensive turn planning utility, providing optimum efficiency on
line changes.

What is SPECTRA made of?
The SPECTRA system has been developed by Concept Systems to
accommodate any advances in positioning technology as they happen.
This is achieved by adopting a generalised approach to system design so,
for example, new positioning technologies can be introduced with little
or no change to the software.  All SPECTRA software conforms to Open
Systems standards, which allows users to continuously benefit from
advances in computer technology.

SPECTRA comprises several modules, or Nodes, which are connected
by an Ethernet local area network:
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Spread
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Each Node consists of a process, or group of processes, performing a
specific task.  The Real Time Navigation Unit (RTNU) is supplied as a
VME racked system, performing data acquisition and providing header
output.  Other Nodes run on workstations connected by the local area
network.
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How does SPECTRA work?
Some of SPECTRA’s processes produce information, by measurement or
by calculation (producer processes), others use the information
(consumer processes).  SPECTRA’s Nodes communicate with each other
using the Ethernet network.  Though Nodes can communicate directly
with each other as they all share the same Ethernet, most of the time each
Node communicates only with the Data Server:
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The Data Server stores information supplied by the system’s producer
processes and passes it on demand to consumer processes.  When a
producer process updates information, the Data Server keeps the old
information as well, until there are no consumer processes that need it.

Generally, any information regarding the set-up or configuration of a
Node can be saved to file, then reloaded when required.

Save: Saving to file (via Save or Save As) writes the Node’s current
configuration (i.e. the state stored in memory) to file.  This does not alter
the data used by the Data Server.

Some Nodes can be run independently, purely to configure the required
data.  This is useful, as it means that survey and much other data can be
set up prior to beginning the survey, then loaded for use at
commencement of the survey.

Before the settings of a Node can be of any use to other parts of
SPECTRA, the Node must be connected to the Data Server.  This
enables the Node to obtain data supplied by other Nodes, and also to
supply its own data to other Nodes.
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Any changes you make to the settings within a Node must first be
applied before they are used by the Node itself.

Apply: The term apply means: take account of the edits or changes made by the
user and apply them to the copy of the Node’s data structures currently
held in memory.  This does not change the configuration stored in file or
alter the data used by the Data Server.

Also, because each Node allows its settings to be changed without
immediately affecting the data it has registered with the Data Server, it is
necessary to explicitly submit any changes to the Data Server before
other Nodes can use them.

Submit: The term submit means: take the current state of the data structures in
memory and send them to the Data Server.  This does not change the
configuration stored in file or write to memory.

This general scheme is illustrated in the following diagrams:

Step 1: initial configuration of a Node

Note that the Node need not be connected to the Data Server.

Node
Configure
Node

Save
configuration
to file

Config.
file

Disconnected Data
Server

Other
Nodes

Step 2: loading and/or modifying a Node’s configuration

Note that the Node need not be connected to the Data Server.

Node

Modify configuration,
if required, and apply
changes to Node

Load
configuration
from file

Config.
file

Disconnected Data
Server

Other
Nodes

Step 3: connecting to the Data Server

For communication with other Nodes.

Node

Allows communication,
including use of data from
other Nodes for further
configuration

Connected Data
Server

Other
Nodes
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Step 4: submit settings to the Data Server

To allow other Nodes to use the data.

Node

Submit
configuration

Connected Data
Server

Other
Nodes

For the data defined in the configuration to be used by other Nodes, the
Node submitting the configuration must be running: the configuration is
lost to the Data Server when the Node is stopped.

For more information on the Data Server, see the “SPECTRA User
Manual - Data Server Node”.
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And what is a typical operational cycle?
The following diagram illustrates the process of running a survey using
SPECTRA, and the relationship between this process and the individual
SPECTRA Nodes:
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Chapter 2 -  So how do I use SPECTRA?

This chapter provides an introduction to the general operational features common to all Nodes.  It also
gives an overview of the operations required to set up SPECTRA for use on a survey, and outlines how to
run a line.

References to individual SPECTRA Nodes occur throughout this chapter.  Each Node has a discrete user
manual; please refer to these manuals for full details on Node operations.

Start-up
Before you can use SPECTRA, it must have been installed as explained
in the Installation Manual.  After installation, you can start up as follows:

1. Power up the workstation(s).

2. Log on as SPECTRA user.

3. Start the required SPECTRA Nodes.

Use the Monitor Node to start SPECTRA (type: mn& at the command
line).  This starts Nodes in the required order, as defined in an
initialisation file.  Alternatively, you can start Nodes individually from
the command line, but this is only recommended for experienced users as
the order in which the Node are started, and their start-up parameters, are
crucial to SPECTRA’s operation.

For further information on the Monitor Node’s initialisation file and
details of each Node’s start-up parameters and options, see the Spectra
Software Installation and Set Up manual.

Using SPECTRA’s graphical user interface
All the SPECTRA Nodes that you see have a graphical user interface.
These all operate in the same way, so you do not have to learn separate
features and operations for each Node.

Common features include:

•  general use of the mouse buttons;

•  the use of a Node’s main window and sub-windows to carry out
operations; and

•  the use of “executive” buttons on a window to apply and submit
configuration changes, and exit from the window.

Common operations include:

•  connecting to and disconnecting from the Data Server, and viewing
communications errors (via the Communications menu);

•  selecting or specifying a file (for opening or saving the
configuration);
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•  opening and saving configuration files (via the File menu on a
Node’s main window);

•  obtaining help; and

•  exiting from the Node (via the File menu on a Node’s main window).

These are outlined below.

Use of mouse buttons
The following general use of mouse buttons applies throughout the
whole system:

•  Left clicking on a menu in the menu bar will show the menu’s
options.  Left clicking on an option will select it.  For example:

•  Left clicking when pointing the mouse cursor at a list item will select
it.  For example:

•  Double (left) clicking on an item from a list will produce some
default action (such as OK, or show an Editor window).

•  Left clicking in a data field will place the cursor in the field ready for
you to edit its contents.  You can click, hold, drag and release to select
part of the field’s contents to over-type, or simply delete and type the
required data in the field.

•  Whenever a text field requires entry of an item from a set defined
elsewhere in the system, right clicking in the field will produce the list
to choose from.

•  Left click on buttons to operate them, for example:

•  Left click on check boxes to turn them on or off, for example:

•  Left click on one of a set of radio buttons to turn it on, and the others
in the set off, for example:
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The main windows
When you start a Node, either its main window or its icon appears,
depending on the setting of the PN_PAN environment variable.  Shrink
the window to an icon and expand the icon to the window as needed.

From the main window, you can open and save files, establish or break
communication with the Data Server, submit information to the Data
Server, access help and exit the Node.

The main window’s Communication status field displays the current
status of the communications link between the Node and the Data Server.
The Change Status field(s) indicate any configuration changes made but
not yet submitted.

For most Nodes you can also call up sub-windows from the main
window, to view or configure various aspects of the Node’s operation.

The sub-windows
Many Nodes have options which call up sub-windows.  Some of these
sub-windows simply display information; others allow you to configure
various aspects of the Node’s setting.  In turn, these sub-windows may
have sub-windows of their own in which to configure settings or display
information.

The following diagram illustrates the relationship between a Node’s
main and sub-windows, and the types of operations performed on each:

• Make changes to configuration

• Use Help

• Display Information

Sub-Window

TO DATA SERVER

• Submit to Data Server

• Open a File

• Save a Configuration

• Exit the Node

• Use Help

Main Window

Submit

Apply

Apply

Apply

DATA FROM OTHER
NODES

• Make changes to configuration

• Use Help

• Display Information

Sub-Window

• Make changes to configuration

• Use Help

• Display Information

Sub-Window• Make changes to configuration

• Use Help

• Display Information

Sub-Window
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The “executive” buttons
The common operations of applying and submitting configuration
changes can be performed from a window’s File menu, or by using the
short-cut “executive” buttons shown on most windows.

Submit button The main window on most SPECTRA Nodes has a
Submit button.  Use this to submit configuration changes
to the Data Server.  This is an alternative to using the
Submit option from the window’s File menu.

Many sub-windows of SPECTRA Nodes have the following buttons:

Apply button Use this to apply configuration changes without closing
the sub-window.  This is an alternative to using the
Apply option from the window’s File menu.

OK button Use this to apply configuration changes and close the
sub-window.  This is an alternative to using the Apply
option from the window’s File menu, followed by the
Close or Exit option from the File menu.

Cancel button Use this to close the sub-window without applying any
configuration changes.  This is an alternative to using the
Close or Exit option from the File menu.

To connect to / disconnect from the Data Server
Each Node in SPECTRA needs to exchange information with the Data
Server and therefore must be connected to it.  If you started SPECTRA
from the Monitor Node, each Node will have been automatically
connected, and will remain so unless you disconnect it or communication
errors occur.  In case of errors, you may need to connect or disconnect
the Node manually.

To connect to or disconnect from the Data Server use the
Communications menu on the Node’s main window to show the
following options:

Select the Connect option to connect the Node to the Data Server, which
then furnishes the Node with a channel for communication.  The Node’s
data can then be submitted to the Data Server for use by other Nodes.
You cannot select this option if you are already connected.

Connecting: Connecting in itself does not submit data.  Connecting to the Data Server
will allow the Node to obtain data provided by other SPECTRA Nodes.

Select the Disconnect option to disconnect the Node from the Data
Server.  This will remove from the Data Server any data items previously
produced by the Node.  You cannot select this option if you are already
disconnected.

Disconnecting: Disconnecting removes all configuration data for this Node from the
Data Server.
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The Communications status field on the main window displays the
current status of the communications link between the Node and the Data
Server.  The status will be one of:

Connected The communications link is operating without problems.

Disconnected The communications link has not been established, or
has been deliberately disconnected.

In either case, if “(Errors)” is appended to the status this indicates that
there is some problem with data transfer.  Use Communications|Last
Error to display a window providing a written explanation of the last
known error.

When there are no errors, the message window reads:

Press OK to remove the window from the screen.

If errors are shown, read the messages displayed and fix the problem(s)
causing the error(s).  Press Clear to clear the error buffer.  You will not
be able to connect to the Data Server unless the error(s) are cleared.

To read a configuration from file
To read a configuration from file, use the Open option from the File
menu on a Node’s main window.  For most Nodes, the following menu is
displayed:

Selecting Open will display the File Select window shown  in “Selecting
a file” on page 2-6.  Use this window to find and select the file to open.
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Selecting a file

The file you select to open must be a permanently saved configuration
file for the Node in question.  As there may be numerous configuration
files saved on your hard disk, use a file filter to narrow your search.

The Directories List
Lists the sub-
directories within the
current directory.

The Filter Field
Displays the complete
path to the files listed,
along with any file
parameters defined.

The Files List
Displays either: all the files
in the current directory; or,
all files that match the filter
condition specified in the
Filter field (providing the
filter is activated using the
Filter button).

The Selection Field
Displays the complete
current directory path and,
if a file is selected, the
name of that file.

In the Filter field, enter the complete directory path to the file(s) you are
interested in.  Or, if appropriate, select a directory from the Directories
field.  Additionally, you may use wild cards, for example, an entry of
“*.SCN” would limit the search to those files in the current directory
which had the suffix “.SCN”, while an entry of “*con.*” would search
out those files whose name ended in “con.” with any suffix.

Activate the filtering process by clicking the Filter button.  The files
displayed in the Files list box will be limited to those which satisfy the
particular conditions.

Opening a file

To open the file that you have selected, press OK.  The configuration
data is read from the specified file and all existing configuration data
will be replaced by the values in the file.  The old values will be lost,
unless you have already saved them.  The File Selection window will
close.

Note: The values you read from file only replace those held in the Node.  The
actual configuration used by the Data Server does not change unless you
Submit the new values (see “To submit configurations to the Data
Server” on page 2-8).
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To configure a Node
Changes to a Node’s configuration are made via sub-windows.  The
exact procedures for making or altering configurations vary between
Nodes and between parameters.  These variations are detailed in each
individual Node’s user manual.  There are some common principles
however.

To make the altered configurations the current ones, choose the Apply
button or select the Apply option from the File Menu.  This will copy the
data on display to local memory.

Alternatively, choose the OK button.  This will apply any changes which
you may have made and close the window.

Applying changes to the configuration, in any of the ways described
above, will result in a “Changed since last submitted” message in the
appropriate Change Status field on the main window.  This is to alert you
to the fact that the data in memory is different from that held in the Data
Server (which is the data used by the other Nodes) and it will remain so
until you submit the new data.

To close the sub-window and return to the main window, use the Cancel
button or select Close from the File menu.  If you made changes to the
definitions but failed to apply them, these changes will be lost and all
values for the configuration will remain as before.

To save a new or modified configuration
To save a new or modified configuration to file, use either the File|Save
or File|Save As option from the menu on a Node’s main window.  This
will preserve the configuration data for future use.

Save This option saves the configuration to the currently open configuration
file, overwriting the previously stored values in the file.  If you wish to
preserve the previous configuration, you can save the file under a new
name (see the Save As option below).

Save As Use this option to save the new or modified configuration under a
different file name, thus preserving the previous configuration file.
Selecting this option will display the File Select window (see “Selecting
a file” on page 2-6).  Enter a new file name in the Selection field or
alternatively select the file to which the configuration will be written.
Press OK and the file will be saved under the new name (and path, if a
different one is specified).
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To submit configurations to the Data Server
Whilst the Data Server holds configuration data, it is volatile and lost
when the Data Server is shut down.  Each time SPECTRA is started up,
configuration data must be presented to the Data Server by each Node.
This is usually accomplished by reading in the saved configuration for
the Node then submitting it to the Data Server.

To submit configuration data to the Data Server, use the Submit button or
choose the File|Submit option from the menu on the Node’s main
window.  This will send the current configuration to the Data Server.
This then becomes the configuration actually used by the Data Server
and made available for use by other SPECTRA Nodes.

To access help

… from main windows

Select Help from the menu on the Node’s main window.  Help displays
the following options:

Contents This displays a general help topic for the Node.  From here, you can call
up help on use of all the Node’s windows.

Search This shows a search box, which you can use to search for help topics
containing specified words in either their titles or the text.  (Note that
there is also a search button on the Help window itself: this lets you
search for topics associated with pre-defined keywords.)

Help On This displays help on use of the Node’s main window.

How To Use Help This shows help on the On-Line Help system itself.

… from sub-windows

On a Node’s sub-windows, the Help menu gives the following options:

Help On This displays help on use of this window.

To exit the Node
To leave the Node, select File|Exit from the menu on the Node’s main
window.  Use this only when you are finished with the Node, and it is
not to continue running.  When you exit, all configuration data for this
Node is removed from the Data Server.

Note that some Nodes must be present at all times during normal
operation of SPECTRA.  To optimise screen space, you can shrink the
window to an icon by selecting the window shrink box.
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